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Application Fundamental 

• Android apps are written in the Java  
• The Android OS is a multi-user Linux system  
• Android app lives in its own security sandbox 

– System assigns each app a unique Linux user ID 
– Each process has its own virtual machine 
– Every application runs in its own Linux process. 

• The Android system implements the principle of 
least privilege 

• How can an app share data with other apps? 
http://developer.android.com/guide/components/fundamentals.html 

http://developer.android.com/guide/components/fundamentals.html


Software Downloads 

• Java Compiler 
– Latest JDK (JRE alone will not work) 

• Java SE 8u20 or Java SE 7u67 

• Android Developer Tools (ADT) 
– Download ADT Bundle form 

http://developer.android.com/sdk/index.html 
– SDK for existing IDE 

 
 

http://developer.android.com/sdk/index.html


Environment Setup 

• Three basic steps to get an application running 
on an Android emulator ADT (or on device) 
– Step 1: Configure the SDK 
– Step 2: Define emulator type and device 
– Step 3: Build and run your first Android App 

 



Step-1: Configure the SDK 

• Unzip ADT Bundle to a known location and give some 
meaningful name (say ADT) 
– Install the Eclipse ADT Bundle 

• Unpack the ZIP file (named adt-bundle-
<os_platform>.zip)  to ADT folder 

• Open the ADT/eclipse/ directory and launch eclipse. 

– That's it! 

http://developer.android.com/sdk/installing/adding-packages.html 

Caution: Do not move any of the files (i.e. eclipse/ or sdk/) or directories from the 
ADT directory. If you do so, you'll need to manually update the ADT preferences. 



Configure the SDK for Existing IDE 

• Install Eclipse IDE 
– Eclipse 3.7.2 or above 

• Eclipse JDT plugin 

– Run Android SDK starter package 
– Install ADT plugin 

• Eclipse > Help > Install New Software … -> Add 
– https://dl-ssl.google.com/android/eclipse/ 

• Configure ADT plugin 

http://developer.android.com/sdk/installing/installing-adt.html 

http://developer.android.com/sdk/installing/installing-adt.html


Eclipse ADT Plugin Configuration 

Specify Android SDK location Increase ADT connection time out 

At Windows > Preferences > Android 



Install SDK Packages 

• Start your Android SDK manager 
– ADT/SDK Manager.exe  or 

 
 
 

• Installed  
packages  



Install SDK Packages 

• You should install the packages in two steps:  
– Select packages in "Tools" only (Android SDK Tools, 

Android SDK Platform-tools, Android SDK Build-
tools). Download and install these.  

– After successful installation of packages in "Tools", 
quit and re-start Eclipse to continue with the rest 
of the installations. 



Step-2: Android Virtual Device (AVD) 

• Define and Start your Android Emulator 
– Define a virtual device type 
– Define an instance of virtual device based on the 

type we defined 
– Start our instance of virtual device. 



Android Virtual Device (AVD) 
• Define Android Virtual Device type:  

– Start the AVD Manager  
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Android Virtual Device (AVD) 
• Define Android Virtual Device type:  

– Start the AVD Manager  



Android Virtual Device (AVD) 

 



SDK Version Mapping Convention 

http://developer.android.com/guide/topics/manifest/uses-sdk-element.html#ApiLevels 

http://developer.android.com/guide/topics/manifest/uses-sdk-element.html
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API Level 

API Level of built-in methods indicates that it work only with android version with 
API level equal or above that value. E.g. 13 here 



Step-3: Creating a Sample App 

• “Hello, CS5248” 
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Step-3: Creating a Sample App 

• “Hello, CS5248” 



Eclipse > New > Android Project 



The Manifest File 

• Identify any user permissions the application 
requires 

• Declare the minimum API Level required by 
the application 

• Declare hardware and software features used 
or required by the application 

• API libraries the application needs to be linked 

http://developer.android.com/guide/topics/manifest/uses-sdk-element.html


The Manifest file 



Default.properties 



Main Activity Class 



Graphical Layout Editor 



XML Layout File 



Value Resources 



R.java 



Building App 



Building Process 

Running 



No Android Device ? 

Install USB Driver !!! 



1. Install OEM USB Driver from ASUS website. 
http://support.asus.com/download/ and search by Transformer 

2. Update Driver Software from Device Manager 
 
 
 
 
 
 
 
 

3. Locate USB Driver folder 
 
 
 
 

4. Enable USB Debugging at Transformer 

USB Driver Installation 

Update Driver software 

http://support.asus.com/download/


Enabling USB debugging 



After Successful USB Driver Installation 

<sdk>/tools/ddms.bat 



Running Sample App. 



Sample Hello World Code 



Editing Sample Code 

BE PATIENT Since Eclipse may not be responsive for a long time !!! 

Add id to main.xml 

Edit HelloWorldActivity.java 

“@+id/helloId” 

Important points 
• UI Element can have an Id 
• Variables in our code link to 

UI elements 
• update UI element content 

from our program code 
whenever we like 



A Sample Code 

Important points 
1. UI Element can have an Id 
2. Variables in our code link to 

UI elements 
3. Update UI element content 

from our program code 
whenever we like 

1 2 

3 



App Failure 



Let’s Debug the code 



Always, Look at DDMS !!! 



Correction 



Debugging via Dalvik Debug Monitor 
Service (DDMS) 

Log.e("Hello, World", "Hello, BJ"); 



Now, everything is ready 



Application Components 

• Android application 
– .apk : android package 

• Four Application Components 
– Activity 
– Service 
– Content Provider 
– Broadcast Receiver 

• Communication among components except 
Content Provider 
– Intent 

 



Activity 1 

• Activity Lifecycle • Implement Lifecycle  
Callbacks 



Activity 2 

• Hierarchical View 
Architecture 
– ViewGroup (Layout) 

• View 
• View 
• ViewGroup (Layout) 

– View 
– View 
– … 

• View 
• ViewGroup 

– … 

• Declare Activity in the 
manifest 
 



Activity 3 
• Start an Activity 

 
• Start an Activity for a 

Result 
– Caller Activity 

 
 
 
– Callee Activity 

 
• finish 

 

• Activities and Stack 
 



Services 

• A service is a component that runs in the bg to 
perform long-running operations  

• A service does not provide a user interface 
• Another component, such as an activity, can start 

the service and let it run or bind to it in order to 
interact with it 

• A service is implemented as a subclass of Service  
• E.g a service might play music in the background 

while the user is in a different app 



Broadcast Receivers 

• A broadcast receiver is a component that 
responds to system-wide broadcast 
announcements 

• Apps can also initiate broadcasts 
• Although broadcast receivers don't display a UI, 

they may create a status bar notification to alert 
the user when a broadcast event occurs 

• A broadcast receiver is implemented as a subclass 
of BroadcastReceiver and each broadcast is 
delivered as an Intent object.  
 



Content Providers 

• A content provider manages a shared set of app 
data 

• Through the content provider, other apps can 
query or even modify the data  

• Any app with the proper permissions can query 
part of the content provider 

• A content provider is implemented as a subclass 
of ContentProvider and must implement a 
standard set of APIs that enable other apps to 
perform transactions.  
 
 



Intent 

• An intent is an abstract description of an 
operation to be performed 
– It can be used with startActivity to launch an 

Activity 
– broadcastIntent to send it to any interested 

BroadcastReceiver components 
– startService(Intent) or bindService(Intent, 

ServiceConnection, int) to communicate with a 
background Service 

http://developer.android.com/reference/android/content/Context.html
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Activating Components 

• Passing an Intent to startActivity() or 
startActivityForResult() 

• passing an Intent to startService(). Or bind to 
the service by passing an Intent to bindService(). 

• Passing an Intent to methods like 
sendBroadcast(), sendOrderedBroadcast(), or 
sendStickyBroadcast(). 

• perform a query to a content provider by calling 
query() on a ContentResolver. 

http://developer.android.com/reference/android/content/Intent.html
http://developer.android.com/reference/android/content/Context.html
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UI – Declaring Layout 

• Initiated when called setContentView() on onCreate() 
 
 

• Use Visual Layout Editor for initial layout design. 
• Edit XML file extensively. 

wrap_content or fill_parent 



UI – Creating Menu 

• Menu Types 
– Options Menu 

• Appears when a user touches MENU button. 
– Context Menu 
– Submenu 

• How to 
– Specify menu items in a XML resource menu 
– Inflate a Menu Resource 
– Respond to user Action 

At res/menu/game_menu.xml  inflate 

callback 



UI – Handling UI Events 

• onClick, onLongClick, onKey, onTouch, … 
 



Thread 

• UI Thread 
– “Main” thread per application responsible for interacting with UI 

components. 

• “Application Not Responding” problem 
– If UI thread is blocked more than several seconds, ANR dialog appears. 
– Do not block the UI thread 
– Do not access UI components outside UI thread. 

 
 
 
 
 
 modify 



Use AsyncTask, Instead 



Misc - Media Recorder 

• Modify CameraPreview to see the video 
during recording. 



Misc - HTTP Post 

• Use HttpClient and HttpPost. 
• Use “multi-part/form-data” to encapsulate 

segment. 
• Do not excessively use memory. 



Misc – Permission Issue 

• Add following permissions to the manifest file. 



Sample Implementation 
MainActivity 

RecordActivity 

Upload Service 

PlayerActivity 

Option menu Context menu 

Record  

Record Button Click  

Preview Item Click  Upload Item Click  



Upload Service 



Misc - Integration with MP4Parser 

• Adding a jar file 
– Create its jar file. 
– Add jar file to the app. 

• Build Path > Configure Build Path > Libraries > Add JARs. 

• If you include source files directly, 
– Put Isoparser-default.properties to assets folder 
– Change getResourceAsStream(“isoparser-

default.properties”) in PropertyBoxParserImpl to 
“/assets/isoparser-default.properties”. 

 
 

https://code.google.com/p/mp4parser/ 
https://github.com/sannies/mp4parser 



Misc - Adapter 

• An Adapter object acts as a bridge between an 
AdapterView and the underlying data for that 
view (i.e. ListView, GridView, Gallery, etc.). 

•  An AdapterView is a view whose children are 
determined by an Adapter.  

 

http://developer.android.com/reference/android/widget/AdapterView.html 
http://developer.android.com/reference/android/widget/Adapter.html 



Misc - Fragments 
• A Fragment represents a behavior or a portion of 

user interface in an Activity.  
• A fragment must always be embedded in an 

activity and the fragment's lifecycle is directly 
affected by the host activity's lifecycle. 

http://developer.android.com/guide/components/fragments.html 



Misc - Connecting to NUS Wifi 



Final Comment: Use ApiDemo !!! 



General Reference 
• How to work with Android GUI layouts 

https://www.youtube.com/watch?v=xn9KYnwIoBE 
• Building and running your app 

http://developer.android.com/tools/building/building-eclipse.html 
• Deployment of the .apk file 

http://stackoverflow.com/questions/3480201/how-do-you-install-an-
apk-file-in-the-android-emulator  

• Find the hidden developer option http://www.cnet.com/how-
to/restore-the-developer-options-menu-in-android-4-2/ 

• Rotation lock/unlock http://www.howtogeek.com/howto/26715/how-
to-make-your-android-phone-stop-rotating-the-screen-when-
you%E2%80%99re-reading-sideways/    

• Video tutorials http://www.youtube.com/watch?v=5RHtKIo_KDI  
• Load/Open an existing package (e.g., the provided ClassExamples) into 

your eclipse  
– File --> Import ... --> General-Tab --> Existing Projects into Workspace (and 

click Next) 
– Select root Directory: click Browse: select the folder the include the 

AndroidManifest.xml or project.properties files. 
– Click finish 

https://www.youtube.com/watch?v=xn9KYnwIoBE
http://developer.android.com/tools/building/building-eclipse.html
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